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LỜI GIỚI THIỆU 

Adobe Illustrator, một công cụ mạnh mẽ cho các nhà thiết kế đồ họa. Trong khóa 

học này, chúng ta sẽ khám phá cách sử dụng Illustrator để biến những ý tưởng trừu 

tượng thành hiện thực trên màn hình. 

Nội dung tài liệu này bao gồm: Giới thiệu về Adobe Illustrator, các khái niệm cơ 

bản và giao diện người dùng. Các công cụ và kỹ năng cơ bản, sử dụng các công cụ 

vẽ cơ bản: Pen Tool, Shape Tool, và Pencil Tool. Cách tạo và sử dụng layers để tổ 

chức công việc. Chỉnh sửa và biến đổi hình ảnh, chỉnh sửa hình ảnh vector. Biến đổi 

các hình ảnh và sử dụng các hiệu ứng, tạo và chỉnh sửa văn bản, tạo các đoạn văn 

bản và sử dụng các tính năng văn bản nâng cao. Thêm hiệu ứng và biến đổi văn bản, 

tính năng đặc biệt của Illustrator, sử dụng các công cụ vẽ tự do và các công cụ khác 

để tạo các hiệu ứng động, thực hành tạo biểu đồ và biểu đồ đơn giản, xuất bản và 

chia sẻ công việc, các cài đặt xuất tệp và quản lý dự án.  

Trong suốt khóa học này, chúng ta sẽ học và áp dụng từng bước một, từ cơ bản 

đến nâng cao, để bạn có thể tự tin sử dụng Illustrator để thể hiện sự sáng tạo của 

mình. Cùng nhau, chúng ta sẽ khám phá thế giới vô tận của đồ họa vector và tạo ra 

các tác phẩm đẹp mắt. 

Do thời gian nghiên cứu và biên tập có hạn, giáo trình này không thể tránh khỏi 

những thiếu sót, tôi rất mong sẽ nhận được những ý kiến đóng góp quý báu của quý 

đồng nghiệp và các bạn sinh viên để giáo trình hoàn thiện hơn.  

Trân trọng ! 

 Thành phố Hồ Chí Minh, ngày    tháng    năm 2021 
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ILLUSTRATOR chuyên về vẽ ra các hình ảnh mới - dựa trên việc tạo và 

chỉnh sửa vector (các điểm toạ độ trên mặt phẳng thiết kế; kết nối tạo thành 

các path với đặc tính màu sắc, hình dạng, độ dày).  

Các thiết kế trên ILLUSTRATOR khi in ấn thường giữ màu sắc, đường 

nét sắc xảo. Ngoài ra, các file xuất ra từ Adobe Illustrator nhẹ và dễ dàng 

thay đổi, hoặc tương thích với các phần mềm khác như Photoshop, Corel 

Draw.  

ILLUSTRATOR hỗ trợ việc in ấn lớn hơn kích thước thiết kế mà không bị 

lỗi, do không phải làm việc trên pixel giống Photoshop, vì thế các thiết kế 

trên Adobe Illustrator rất linh hoạt. 

Lưu ý: 

Hình ảnh raster là gì? 

Hình ảnh raster được tạo thành từ một lưới các chấm được gọi là pixel 

trong đó mỗi pixel được gán một màu. Hình ảnh raster phụ thuộc vào độ 

phân giải, nghĩa là chúng tồn tại ở một KÍCH THƯỚC NHẤT ĐỊNH. Khi bạn 

chuyển đổi một hình ảnh raster, bạn kéo dài các pixel, điều này có thể dẫn 

đến một hình ảnh bị mờ, hụt pixel (do nó không biết lấy pixel ở đâu lấp vô). 

Hình ảnh vector là gì? 

Hình ảnh vector là digital artwork trong đó các điểm, đường và đường 

cong được tính toán bởi máy tính. Về cơ bản, chúng là các phương trình toán 

học và mọi phương trình có thể được gán bằng một màu, nét hoặc độ dày… 

để biến các hình dạng (shapes) thành tác phẩm. 
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Hình ảnh vector là độ phân giải độc lập. Khi bạn thu nhỏ hoặc phóng to 

hình ảnh vector, các shape của bạn sẽ lớn hơn nhưng nó không mất bất kỳ 

chi tiết nào hay được thêm bất kỳ pixel nào, hình ảnh của bạn sẽ luôn hiển thị 

giống hệt nhau, bất kể kích thước, không có loại hình ảnh vector lossy hoặc 

lossless. 

Tạo, mở và lưu file 

Tạo file 

• File => New 

 
Trong đó: 

1. Name: Tê n Filê. 
2. Width: Chiê u ngang Filê. 
3. Height: Chiê u cao Filê. 
4. Đơn vi  đo: Pixcel, Centimeters, …. 

https://blogdaytinhoc.com/giao-trinh-tu-hoc-illustrator-tu-co-ban-den-nang-cao-551#bai_tap_thuc_hanh
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5. Artboards: So  trang chu ng ta la m viê  c. Ma  c đi nh la  1. 
6. Bleed (Bao go m Top, Bottom, Lêft, Right): Chừ a lê  cu a Filê. 
7. Color Mode: Chê  đo   ma u cu a Filê.  
8. Raster Effects: Đo   pha n gia i cu a Filê. 

Mở file 

• File => Open 

Lưu file 

• File => Save As 

Khi lưu File với đuôi “.ai” Phần mềm sẽ hiện 1 hộp thoại cho phép chúng 

ta tuỳ chọn lưu File ở Version nào. Vì vậy, khi lưu File chúng ta sẽ chọn 

Version “Illustrator CC (Legacy)” để tất cả các phiên bản đều có thể mở 

được.  

Ví dụ: Bạn lưu File với Version “Illustrator 2020” thì File của bạn chỉ mở 

được với các phiên bản “Illustrator 2020” trở lên, ngược lại các phiên bản thấp 

hơn sẽ không mở được. 
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Ngoài ra chúng ta có thể xuất File ra PNG, JPG, SVG, … bằng cách File 

=> Export => Export As. 
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Cách sử dụng Artboards 

Artboards 

 

Artboards (bản vẽ) trong Adobe Illustrator là là một không gian giúp 

bạn làm việc trên nhiều “bản vẽ” khác nhau. (có thể hiểu đơn giản là số trang 

giấy). Mỗi vùng làm việc gọi là 1 Artboards. 

Phím tắt là Shift + O. 

Sử dụng Artboards trong trường hợp một bản thiết kế cần nhiều trang. 

Ví dụ: Card visit, catalogue,… 
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Quản lý Artboards: Window => Artboards. Tại đây chúng ta có thể đặt 

tên, thêm mới, xoá và sắp xếp Artboards. 

 

Ví dụ tính năng Artboards 

Ví dụ 1: Giả sử, ta có 4 Artboards. Trong Artboards 1, ta có logo Sao 

Việt. Bây giờ chúng ta có thể copy logo Sao Việt ra nhiều Artboards khác 

bằng cách:  

• Click cho n copy logo Sao Viê  t. 

• Edit => Paste on .All Artboards. 
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Ví dụ 2: Giả sử, ta có 4 Artboards. Đặt 1 hình ngôi sao giữa 4 Artboards. 

Bây giờ ta hãy lưu dạng PDF. Kết quả là mỗi trang PDF sẽ chứa 1 phần của 

ngôi sao. 
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Giao diện làm việc trong Illustrator 

 

Màn hình làm việc gồm: 

1. Thanh tiêu đề: Chừ a biê u từơ ng chừơng trì nh, tê n ta i liê  u, ty  lê   thu pho ng, 
hê   ma u, đo ng chừơng trì nh. 

2. Thanh chức năng: Chừ a ca c mênu lê  nh la m viê  c cu a chừơng trì nh. 
3. Thanh công cụ: Chừ a ca c co ng cu  la m viê  c cu a chừơng trì nh, chu ng ta co  thê  

click mu i tê n đê  mơ  ro  ng chu ng. 
4. Thanh Panel: Ở  thanh na y sê  từơng ừ ng vơ i nhừ ng mênu trong thanh chừ c 

na ng Window.   

Một số lệnh - phím tắt cơ bản  

Một số lệnh cơ bản: 

• Selection Tool (V): Lừ a cho n ca c đo i từơ ng ca n la m viê  c. 

• Direct Selection Tool (A): Đừơ c sừ  du ng đê  cho n ca c đừơ ng hoa  c đoa n 
riê ng biê  t cu a mo  t đo i từơ ng, hay no i ca c kha c no  đừơ c du ng đê  cho n điê m 
nêo trong mo  t hì nh vê , va  đừơ c du ng đê  na n chì nh hì nh đo . 
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• Magic Wand Tool (Y): Du ng đê  cho n ca c đo i từơ ng. Cho phê p cho n nhanh 
1 loa t ca c đo i từơ ng co  cu ng thuo  c tì nh gio ng nhau ( VD: ca c đo i từơ ng co  
ma u gio ng nhau). 

• Lasso Tool (Q): Đừơ c sừ  du ng đê  ta o ca c vu ng cho n ba ng ca ch rê  xung 
quanh ca c đo i từơ ng mong muo n. 

• Pentool (P): Đừơ c sừ  du ng đê  vê  ca c đoa n đừơ ng tha ng va  đừơ ng cong. 

• Zoom Tool (Z): Co ng cu  zoom nhừ mo  t kì nh lu p đê  pho ng to va  thu nho  
Workspacê. Đê  pho ng, nha p ba t cừ  nơi na o trê n Artboard nha n phì m ta t 
Ctrl + “+”, đê  thu nho  nha n phì m ta t Ctrl + “-“.   

• Hand Tool (H): Sừ  du ng co ng cu  hand đê  đi nh la i vi  trì  khung xêm cu a 
Artboard ba ng viê  c rê  khung xêm lê n suo ng sang tra i hoa  c pha i. 

• Ctrl + 0: Từ  đo  ng chì nh full ma n hì nh vê  đu ng vu ng đang la m viê  c. 

• Ctrl + 1: Từ  đo  ng chì nh chê  đo   Zoom vê  đu ng 100%. 

Một số phím tắt cơ bản: 

• Transform Again (Ctrl+D): La  p la i bừơ c cuo i cu ng chu ng ta đa  thừ c hiê  n, 
a p du ng trừơ ng hơ p nha n ba n đo i từơ ng nhanh va  đê u. 

• Shift + click chuột: Thê m lừ a cho n. 

• Ctrl + 2: Khoa  ca c layêr. 

• Ctrl + Alt + 2: Mơ  khoa  ca c layêr. 

• Alt + kéo đối tượng: Nha n đo i. 

• Phím I: Hu t ma u ma u. 

• Spacebar: Di chuyê n vu ng. 

• Bring to Front (Ctrl + Shift + ]): Đừa đo i từơ ng đừơ c cho n lê n trê n cu ng. 

• Bring Forward (Ctrl + ]): Đừa đo i từơ ng đừơ c cho n lê n trê n mo  t vi  trì . 

• Send Backward (Ctrl + [): Đừa đo i từơ ng đừơ c cho n xuo ng dừơ i mo  t vi  
trì . 

• Send to Back (Ctrl + Shift + [): Đừa đo i từơ ng đừơ c cho n xuo ng dừơ i 
cu ng. 
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Các nhóm công cụ hình học cơ bản 

Nhóm công cụ Line Segment 

 

• Line Segment Tool (\): Sừ  du ng đê  ta o ca c đoa n đừơ ng tha ng. 

• Arc Tool: Vê  ca c đừơ ng cong, co  thê  kho ng tha  chuo  t tra i va  kê t hơ p phì m 
mu i tê n lê n xuo ng. 

• Spiral Tool: Vê  đừơ ng xoa n o c. 

• Rectangular Gird Tool, Polar Gird Tool: Vê  đừơ ng lừơ i vuo ng, tro n. 
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Nhóm công cụ vẽ hình khối 

 

• Rectangle Tool (M): Vê  hì nh vuo ng, chừ  nha  t, hì nh tru . 

• Rounded Rectangle Tool: Vê  hì nh chừ  nha  t, hì nh vuo ng, hì nh tru  bo tro n 
ca c go c. 

• Ellipse Tool: Vê  hì nh êlip. 

• PolygonTool: Vê  ca c hì nh đa gia c. Co  thê  thê m bơ t ca nh hì nh đa gia c ba ng 
ca ch nha n phì m mu i tê n lê n xuo ng. 

• Star Tool: Vê  ngo i sao. Co  thê  thê m bơ t ca nh hì nh đa gia c ba ng ca ch nha n 
phì m mu i tê n lê n xuo ng. Nha n Alt ca c ca nh sê  đê u hơn. 

• Flare Tool: Ta o a nh sa ng lo ê. 

Lưu ý: 

• Nhấn kết hợp Shift: Shapê đang vê  sê  đừơ c đê u hơn. 

• Nhấn kết hợp Alt: Chu ng ta sê  vê  đừơ c hì nh từ  ta m đi ra. 



TÀI LIỆU THAM KHẢO 

 

 

 

THIẾT KẾ QUẢNG CÁO VỚI ADOBE ILLUSTRATOR 

  18 

 

 

 

• Kết hợp Shift + Alt: Chu ng ta sê  vê  đừơ c hì nh đê u hơn va  đi ra từ  ta m. 

Mỗi Shape được gọi là 1 Object. Muốn hiệu chỉnh các Shape thì sẽ nằm 

trong thanh menu Object.  

Stroke - Outline Stroke 

 

Một đối tượng trong Illustrator sẽ mang hai yếu tố để đổ màu, đó chính 

là Fill và Stroke. Fill là phần màu nền bên trong của đối tượng còn Stroke là 

màu viền. 

Chúng ta có thể chuyển Stroke thành Shape vector để thực hiện các 

thao tác điều chỉnh phức tạp hơn như cắt, ghép,… 

Thao tác biến Stroke thành vector: 

Bước 1: Chọn đối tượng cần biến thành vector. 

Bước 2: Vào hộp thoại Object => Path => Outline Stroke. 
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Công cụ Shape Buider tool 

 

• Shape Builder Tool (Shift + M): La  co ng cu  ra t ca n thiê t cho viê  c thiê t kê  
logo. cho phê p ngừơ i du ng ta o ca c đo i từơ ng phừ c ta p ba ng ca ch go  p va  
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xo a ca c đo i từơ ng đơn gia n, cho n ca c ca nh va  vu ng cu a đo i từơ ng co  thê  
go  p hoa  c xo a đê  ta o đo i từơ ng mơ i. Hoa  c ngoa i ra ngừơ i du ng cu ng co  thê  
pha  vơ  ca c đo i từơ ng đừơ c cho ng chê o đê  ta o đo i từơ ng mơ i. 

• Ma  c đi nh co ng cu  Shapê Buildêr ơ  chê  đo   Merge (go  p), tuy nhiê n nê u 
muo n ba n co  thê  chuyê n đo i sang chê  đo   Erasê (xo a) ba ng ca ch sừ  du ng 
phì m Alt (trên Windows) hoặc Option (trên Mac). 

• Kê t hơ p phì m ALT thì  sê  từ  đo  ng loa i bo  (xoa ) đi nhừ ng đo i từơ ng na m 
trong pha m vi khê p kì n. 

Transform và Align 

Rolate Tool 

 

Nhấn chọn công cụ Rotate Tool (phím tắt R), lúc này sẽ có 1 điểm màu 

xanh xuất hiện ở trọng tâm của đối tượng. Điểm này được gọi là tâm xoay, 

bạn có thể di chuyển nó đến bất cứ vị trí nào bạn muốn. 

Lưu ý: Bạn hãy nhấn phím Enter trên bàn phím để hiển thị bảng Rotate 

Options với cách này bạn có thể đặt tâm xoay tùy theo ý thích. 
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Reflect Tool 

 

Nhấn chọn công cụ Reflect Tool (phím tắt O), lúc này tâm lật sẽ xuất 

hiện. Bạn hãy giữ phím Alt + Click chuột vào vị trí tâm lật mà bạn muốn đặt. 
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Lúc này bảng Reflect Options sẽ xuất hiện, bạn có thể nhập hoặc tuỳ 

chỉnh các thông số: 

• Horizontal: La  t hì nh thêo chiê u ngang. 

• Vertical: La  t hì nh thêo chiê u do c. 

• Angle: Go c la  t cu a đo i từơ ng. 

• Copy: La  t va  ta o ra mo  t đo i từơ ng mơ i sau khi la  t. 

 

Để xem thử hình lật trước khi đồng ý bạn hãy nhấn nút Preview, sau khi 

ưng ý nhấn OK để lật hình. 
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Free Transform Tool 

 

Lệnh Free Transform dùng để biến đổi tự do góc nhìn của đối tượng. 

Align 

 

Căn chỉnh vị trí tương đối của các đối tượng. 

• Ca n ngoa i cu ng bê n tra i 

• Ca n giừ a thêo chiê u do c 

• Ca n ngoa i cu ng bê n pha i 

• Ca n ngoa i trê n cu ng 

• Ca n giừ a thêo chiê u ngang 
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• Ca n dừơ i cu ng 

Căn chỉnh khoảng cách của các đối tượng. 

• Ca n khoa ng ca ch phì a trê n 

• Ca n ta m thêo chiê u ngang 

• Ca n khoa ng ca ch phì a dừơ i 

• Ca n khoa ng ca ch bê n tra i 

• Ca n ta m thêo chiê u do c 

• Ca n khoa ng ca ch bê n pha i 

Pathfinder 

 

Mở nhóm công cụ này trong menu Window / Pathfinder hoặc nhấn tổ 

hợp phím CTRL + SHIFT + F9. 

Nhóm công cụ Shape Mode 

• Unite: Kê t hơ p ta t ca  ca c đo i từơ ng tha nh 1 đo i từơ ng duy nha t vơ i ma u 
sa c sê  đừơ c la y cu a đo i từơ ng trê n cu ng. 
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• Minus Front: Loa i bo  toa n bo   ca c đo i từơ ng phì a trê n cu ng pha n giao nhau 
cu a ca c đo i từơ ng. Ma u sa c sê  giừ  la i ma u cu a đo i từơ ng dừơ i cu ng vơ i 
pha n đừơ c giừ  la i. 

• Intersect: Giừ  la i pha n giao nhau cu a ta t ca  ca c đo i từơ ng va  loa i bo  ta t ca  
ca c pha n co n la i. Pha n ma u sa c sê  la y ma u cu a đo i từơ ng trê n cu ng. 

• Exclude: Loa i bo  pha n giao cu a ca c đo i từơ ng. 

Nhóm công cụ Pathfinder: 

• Divide: ta ch ca c pha n giao cu a ca c đo i từơ ng ra tha nh nhiê u pha n kha c 
nhau. sau lê  nh na y ba n ca n pha i Ungroup mơ i co  thê  ta ch chu ng ra kho i 
nhau (vì  sau lê  nh Dividê ca c đo i từơ ng bi  ta ch ra đa  nho m tha nh 1 nho m. 

• Trim: Ta ch ca c đo i từơ ng xê p cho ng lê n nhau tha nh ca c đo i từơ ng kha c 
nhau 

• Merge: Thừ c hiê  n từơng từ  nhừ co ng cu  Trim. Co  điê u kha c la , khi ta ch ca c 
đo i từơ ng ra thì  ca c đo i từơ ng gio ng nhau (thừơ ng cu ng 1 ma u sê  đừơ c 
hơ p la i cu ng 1 đo i từơ ng). 

• Crop: La  co ng cu  sê  giu p ba n la y đừơ c pha n giao cu a đo i từơ ng trê n cu ng 
vơ i ca c đo i từơ ng bê n dừơ i no . 

• Outline: Ta o ra ca c đừơ ng linê thêo ca c khuo n hì nh ca c đo i từơ ng đa  đừơ c 
xê p cho ng lê n nhau, thay vì  ta ch nê n thì  ơ  đa y Outlinê chì  xừ  ly  pha n đừơ ng 
viê n strokê. 

• Minus Back: Loa i bo  toa n bo   ca c đo i từơ ng bê n dừơ i cu ng pha n giao vơ i 
đo i từơ ng trê n cu ng. Pha n đừơ c giừ  la i la  đo i từơ ng trê n cu ng vơ i nhừ ng 
pha n kho ng giao vơ i ca c đo i từơ ng bê n dừơ i. 

Cách sử dụng màu sắc 

Gradient Tool 

Bạn có thể mở bảng Gradient bằng cách nhấp vào biểu tượng trên thanh 

công cụ hoặc bằng cách vào Window > Gradient. 



TÀI LIỆU THAM KHẢO 

 

 

 

THIẾT KẾ QUẢNG CÁO VỚI ADOBE ILLUSTRATOR 

  26 

 

 

 

 

Mesh Tool 

Mesh tool hay còn gọi là Gradient mesh là một công cụ giúp tô màu 

dạng lưới trong illustrator. Đây là một công cụ tô màu chuyển sắc đặc biệt 

chỉ xuất hiện trong phần mềm đồ hoạ vector. 

Vào menu Object > Create Gradient Mesh, chúng ta có thể xác định số 

lượng hàng và cột trong hộp thoại. 
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Ví dụ về Mesh Tool 

Đầu tiên, chúng ta vẽ 1 cánh hoa. 

Truy cập, Object > Create Gradient Mesh, nhập Rows và Collumns là 3-

3. 
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Chọn công cụ Mesh Tool, click vào các điểm point để thay đổi màu sắc 

của chúng. 

Làm việc với chữ và văn bản 

Nhóm công cụ Type 

 

• Type Tool (T): Co ng cu  thê m chừ  từ  do va o trang gia y Artboard. 

• Area Type Tool: Chê n chừ  va o 1 hì nh vê  ba t ky . Ba ng ca ch vê  ra 1 hì nh ba t 
ky , sau đo  click va o đừơ ng path. 

• Type On A Path Tool: Du ng đê  viê t lê n trê n ca c đừơ ng hay outlinê bê n 
ngoa i cu a hì nh. 

Pen Tool 

Tương tự như Pen Tool trong Photoshop. Nó có thể được sử dụng để 

tạo ra vô số dòng, đường cong và hình dạng, và đường gấp khúc. 
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Các Thao Tác và Công Cụ Vẽ Hình 
Cơ Bản trong Adobe Illustrator 

1. Mục tiêu 

Sử dụng thành thạo các thao tác cơ bản trên tập tin. 

Sử dụng thành thạo các thao tác cơ bản trên đối tượng. 

Sử dụng thành thạo các nhóm công cụ vẽ hình cơ bản. 

Hiểu được khái niệm “bộ nhận diện thương hiệu”. 

2. Nội dung chương 

2.1. Giới thiệu về Adobe Illustrator 

2.1.1. Giới thiệu 

Adobe Illustrator là một phần mềm đồ họa vector mạnh mẽ được sử dụng rộng 

rãi trong thiết kế đồ họa, minh họa, và tạo ra các tác phẩm nghệ thuật. Với khả năng 

tạo ra các hình ảnh chất lượng cao và linh hoạt, Illustrator là công cụ không thể thiếu 

cho các nhà thiết kế đồ họa chuyên nghiệp. 

2.1.2. Yêu cầu cấu hình cài đặt 

Để cài đặt và sử dụng Adobe Illustrator, máy tính của bạn cần đáp ứng các yêu 

cầu cấu hình sau: 

 

Hệ điều hành: Windows 10 hoặc macOS 10.13 (High Sierra) trở lên 

Bộ xử lý: Intel hoặc AMD với hỗ trợ 64-bit 

RAM: Tối thiểu 8GB (khuyến nghị 16GB) 

Ổ cứng: Tối thiểu 2GB dung lượng trống 

Màn hình: Độ phân giải 1024x768 (khuyến nghị 1920x1080) 

2.2. Các thao tác cơ bản trên tập tin 

Mở, lưu, và đóng tập tin. 

Sử dụng các lệnh Undo, Redo, và History. 
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Sử dụng các định dạng tập tin phổ biến (AI, EPS, PDF, SVG). 

2.3. Các thao tác cơ bản trên đối tượng 

2.3.1. Công cụ Selection Tool 

Cách chọn và di chuyển các đối tượng. 

Chỉnh sửa kích thước và xoay đối tượng. 

2.3.2. Công cụ Direct Selection Tool 

Chỉnh sửa điểm neo (anchor points) và đường cong (paths). 

Tùy chỉnh hình dạng và đường viền của đối tượng. 

2.3.3. Công cụ Group Selection Tool 

Cách chọn và chỉnh sửa các đối tượng nhóm (group). 

2.4. Nhóm công cụ vẽ hình cơ bản 

2.4.1. Công cụ Rectangle Tool 

Vẽ và chỉnh sửa hình chữ nhật. 

2.4.2. Công cụ Rounded Rectangle Tool 

Vẽ và chỉnh sửa hình chữ nhật bo góc. 

2.4.3. Công cụ Ellipse Tool 

Vẽ và chỉnh sửa hình elip. 

2.4.4. Công cụ Polygon Tool 

Vẽ và chỉnh sửa hình đa giác. 

2.4.5. Công cụ Star Tool 

Vẽ và chỉnh sửa hình ngôi sao. 

2.4.6. Công cụ Flare Tool 

Tạo hiệu ứng ánh sáng và flare. 

2.4.7. Công cụ Line Segment Tool 

Vẽ và chỉnh sửa đoạn thẳng. 

2.4.8. Công cụ Arc Tool 
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Vẽ và chỉnh sửa đường cung. 

2.4.9. Công cụ Spiral Tool 

Vẽ và chỉnh sửa hình xoắn ốc. 

2.4.10. Công cụ Rectangular Grid Tool 

Vẽ và chỉnh sửa lưới hình chữ nhật. 

2.4.11. Công cụ Polar Grid Tool 

Vẽ và chỉnh sửa lưới hình tròn. 

2.5. Giới thiệu về bộ nhận diện thương hiệu 

2.5.1. Khái niệm 

Bộ nhận diện thương hiệu (Brand Identity) là tập hợp các yếu tố trực quan và 

cảm xúc mà doanh nghiệp sử dụng để tạo nên bản sắc thương hiệu của mình. Nó bao 

gồm logo, màu sắc, kiểu chữ, và các yếu tố thiết kế khác. 

2.5.2. Các thành phần trong bộ nhận diện thương hiệu 

Logo: Biểu tượng đại diện cho thương hiệu. 

Màu sắc: Bảng màu chủ đạo của thương hiệu. 

Kiểu chữ: Phong cách và loại chữ sử dụng trong các tài liệu truyền thông. 

Hình ảnh và đồ họa: Các yếu tố trực quan bổ sung cho thương hiệu. 

Slogan: Câu khẩu hiệu đặc trưng của thương hiệu. 

2.6. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành các thao tác và sử dụng các công cụ vẽ hình cơ 

bản trong Adobe Illustrator. 

Demo tạo một sản phẩm đơn giản sử dụng các công cụ đã học. 

2.7. Bài tập 

Yêu cầu sinh viên thực hiện các bài tập thực hành sử dụng các công cụ đã học. 

Đánh giá và phản hồi kết quả bài tập của sinh viên. 

Thực hiện: 
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Trong quá trình học tập, sinh viên cần thực hành thường xuyên để nắm vững các 

kỹ năng và thao tác cơ bản. Giáo viên cần hỗ trợ và hướng dẫn sinh viên trong suốt 

quá trình học tập, đảm bảo rằng tất cả các sinh viên đều có thể sử dụng thành thạo 

các công cụ và thao tác cần thiết. 

Tổng kết: 

Qua 10 giờ học, sinh viên sẽ nắm vững các thao tác và công cụ cơ bản trong 

Adobe Illustrator, hiểu được khái niệm và các thành phần của bộ nhận diện thương 

hiệu, đồng thời có khả năng ứng dụng các kiến thức này vào thực tế. 
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Giáo Trình: Công Cụ Transform và 
Pen trong Adobe Illustrator 

1. Mục tiêu 

Sử dụng thành thạo các công cụ biến đổi đối tượng và Pen Tool. 

Có kiến thức về thiết kế Logo, Namecard (Danh thiếp), Letterhead (Giấy tiêu đề), 

Envelope (Phong bì). 

Thiết kế được Logo, Namecard, Letterhead, Envelope bằng các công cụ biến đổi 

đối tượng và Pen Tool. 

2. Nội dung chương 

2.1. Các công cụ Transform 

Các công cụ Transform cho phép bạn thay đổi kích thước, xoay, phản chiếu, biến 

dạng, và tái định hình các đối tượng trong Adobe Illustrator. 

2.1.1. Scale Tool 

Sử dụng Scale Tool để thay đổi kích thước của đối tượng một cách tỷ lệ hoặc 

không tỷ lệ. 

Phím tắt: S 

2.1.2. Rotate Tool 

Sử dụng Rotate Tool để xoay đối tượng quanh một điểm cố định. 

Phím tắt: R 

2.1.3. Reflect Tool 

Sử dụng Reflect Tool để phản chiếu đối tượng qua một trục xác định. 

Phím tắt: O 

2.1.4. Shear Tool 

Sử dụng Shear Tool để làm biến dạng đối tượng theo một góc nhất định. 

Phím tắt: Không có (có thể truy cập từ menu Transform) 

2.1.5. Reshape Tool 
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Sử dụng Reshape Tool để thay đổi hình dạng của đối tượng bằng cách kéo các 

điểm neo. 

Phím tắt: Không có (có thể truy cập từ menu Tools) 

2.1.6. Free Transform Tool 

Sử dụng Free Transform Tool để thực hiện nhiều thao tác biến đổi khác nhau 

như thay đổi kích thước, xoay, và làm biến dạng đối tượng. 

Phím tắt: E 

2.2. Công cụ Pen 

Pen Tool là một trong những công cụ mạnh mẽ nhất trong Adobe Illustrator, cho 

phép bạn vẽ các đường cong và hình dạng phức tạp. 

2.2.1. Pen Tool 

Sử dụng Pen Tool để vẽ các đường thẳng và đường cong bằng cách tạo các 

điểm neo. 

Phím tắt: P 

2.2.2. Add Anchor Point Tool 

Sử dụng Add Anchor Point Tool để thêm các điểm neo vào đường path hiện có. 

Phím tắt: + 

2.2.3. Delete Anchor Point Tool 

Sử dụng Delete Anchor Point Tool để xóa các điểm neo khỏi đường path. 

Phím tắt: - 

2.2.4. Convert Anchor Point Tool 

Sử dụng Convert Anchor Point Tool để chuyển đổi giữa điểm neo góc và điểm 

neo tròn. 

Phím tắt: Shift + C 

2.3. Giới thiệu về Logo, Namecard, Letterhead, Envelope 

2.3.1. Logo 

Logo là biểu tượng đại diện cho thương hiệu, công ty hoặc tổ chức. 
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Đặc điểm: Đơn giản, dễ nhớ, có thể nhận diện ở kích thước nhỏ. 

2.3.2. Namecard (Danh thiếp) 

Namecard là một công cụ giao tiếp quan trọng chứa thông tin liên hệ của cá nhân 

hoặc công ty. 

Đặc điểm: Thiết kế rõ ràng, chứa thông tin cần thiết như tên, chức vụ, công ty, 

địa chỉ, số điện thoại, email. 

2.3.3. Letterhead (Giấy tiêu đề) 

Letterhead là phần đầu của giấy viết thư, chứa thông tin về công ty như tên, logo, 

địa chỉ. 

Đặc điểm: Thiết kế trang nhã, chuyên nghiệp, đồng bộ với các yếu tố thương 

hiệu khác. 

2.3.4. Envelope (Phong bì) 

Envelope là bao thư chứa giấy tờ, thư từ. 

Đặc điểm: Thiết kế đồng bộ với logo và màu sắc thương hiệu, chứa thông tin liên 

hệ của công ty. 

2.4. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành sử dụng các công cụ Transform và Pen Tool. 

Demo tạo một thiết kế Logo, Namecard, Letterhead, và Envelope đơn giản. 

2.5. Bài tập 

Yêu cầu sinh viên thực hiện các bài tập thực hành sử dụng các công cụ đã học. 

Đánh giá và phản hồi kết quả bài tập của sinh viên. 

Thực hiện: 

Trong quá trình học tập, sinh viên cần thực hành thường xuyên để nắm vững các 

kỹ năng và thao tác cơ bản. Giáo viên cần hỗ trợ và hướng dẫn sinh viên trong suốt 

quá trình học tập, đảm bảo rằng tất cả các sinh viên đều có thể sử dụng thành thạo 

các công cụ và thao tác cần thiết. 

 

Tổng kết: 
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Qua 11 giờ học, sinh viên sẽ nắm vững các công cụ Transform và Pen Tool trong 

Adobe Illustrator, hiểu được khái niệm và các yếu tố của Logo, Namecard, Letterhead, 

và Envelope, đồng thời có khả năng ứng dụng các kiến thức này vào thực tế. 
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Giáo Trình: Hiệu Chỉnh Đối Tượng 
trong Adobe Illustrator 

1. Mục tiêu 

Hiệu chỉnh được các đối tượng trong bản vẽ. 

Có kiến thức về Folder, Packaging (bao bì hộp), túi xách. 

Thiết kế được Folder, Packaging (bao bì hộp), túi xách đơn giản bằng các công 

cụ đã học. 

2. Nội dung chương 

2.1. Canh hàng đối tượng với hộp thoại Align 

Hộp thoại Align giúp bạn sắp xếp và canh hàng các đối tượng một cách chính 

xác. 

Align: Cách sử dụng hộp thoại Align để canh hàng các đối tượng theo cạnh trái, 

phải, trên, dưới, hoặc theo trung tâm. 

Distribute: Sử dụng các tùy chọn phân phối để tạo khoảng cách đều giữa các đối 

tượng. 

2.2. Các thao tác lệnh trong Menu Object / Path 

Các lệnh trong menu Object / Path giúp bạn thao tác và hiệu chỉnh các đối tượng 

vector một cách chi tiết. 

2.2.1. Join 

Kết nối hai hoặc nhiều đoạn path lại với nhau. 

Phím tắt: Ctrl + J (Windows) / Command + J (Mac) 

2.2.2. Average 

Làm trung bình các điểm neo để căn chỉnh các đoạn path. 

2.2.3. Outline Stroke 

Biến các đường viền (stroke) thành đối tượng có thể chỉnh sửa được. 

2.2.4. Offset Path 
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Tạo một đường path mới cách đều so với đường path gốc. 

2.2.5. Simplify 

Giảm số lượng điểm neo trên đường path mà vẫn giữ nguyên hình dạng tổng 

thể. 

2.2.6. Add Anchor Points 

Thêm điểm neo vào đường path hiện có. 

2.2.7. Remove Anchor Points 

Xóa các điểm neo khỏi đường path. 

2.2.8. Divide Objects Below 

Chia đối tượng thành các phần khác nhau bằng cách sử dụng một đối tượng 

khác làm mẫu cắt. 

2.2.9. Split Into Grid 

Chia đối tượng thành các ô lưới đều nhau. 

2.2.10. Clean Up 

Xóa các đối tượng không cần thiết hoặc lỗi trong bản vẽ. 

2.3. Các chức năng trong hộp thoại PathFinder 

PathFinder là một công cụ mạnh mẽ giúp bạn tạo ra các hình dạng phức tạp 

bằng cách kết hợp hoặc chia tách các đối tượng. 

2.3.1. Nhóm Shape Modes 

Unite: Kết hợp các đối tượng thành một. 

Minus Front: Trừ đối tượng phía trước khỏi đối tượng phía sau. 

Intersect: Giữ lại phần giao nhau của các đối tượng. 

Exclude: Xóa bỏ phần giao nhau của các đối tượng. 

2.3.2. Nhóm Path Finder 

Divide: Chia các đối tượng thành các phần riêng lẻ dựa trên giao điểm của chúng. 

Trim: Xóa bỏ các phần không giao nhau của các đối tượng. 

Merge: Kết hợp các đối tượng có cùng màu lại với nhau. 
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Crop: Cắt các đối tượng theo hình dạng của đối tượng phía trên. 

Outline: Tạo đường viền quanh các đối tượng. 

Minus Back: Trừ đối tượng phía sau khỏi đối tượng phía trước. 

2.4. Công cụ Shape Builder 

Shape Builder Tool cho phép bạn kết hợp, chia tách và tạo các hình dạng phức 

tạp từ các đối tượng khác nhau một cách dễ dàng. 

Phím tắt: Shift + M 

2.5. Giới thiệu về Folder, Packaging (bao bì hộp), túi xách 

2.5.1. Folder 

Folder là các bìa cứng hoặc nhựa dùng để chứa tài liệu. 

Đặc điểm: Thiết kế đơn giản, dễ nhận diện, có thể gấp lại. 

2.5.2. Packaging (Bao bì hộp) 

Packaging là các loại bao bì được thiết kế để chứa và bảo vệ sản phẩm. 

Đặc điểm: Thiết kế hấp dẫn, chắc chắn, phù hợp với sản phẩm. 

2.5.3. Túi xách 

Túi xách là các loại túi được sử dụng để mang và chứa các vật dụng. 

Đặc điểm: Thiết kế thời trang, tiện lợi, bền chắc. 

2.6. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành hiệu chỉnh các đối tượng bằng các công cụ Align, 

PathFinder, và Shape Builder. 

Demo tạo một thiết kế Folder, Packaging, và túi xách đơn giản. 

2.7. Bài tập 

Yêu cầu sinh viên thực hiện các bài tập thực hành sử dụng các công cụ đã học 
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Giáo Trình: Hiệu Chỉnh Đối Tượng 
trong Adobe Illustrator 

Thời gian: 5 giờ 

1. Mục tiêu 

Hiệu chỉnh được các đối tượng trong bản vẽ. 

Có kiến thức về Folder, Packaging (bao bì hộp), túi xách. 

Thiết kế được Folder, Packaging (bao bì hộp), túi xách đơn giản bằng các công 

cụ đã học. 

2. Nội dung chương 

2.1. Canh hàng đối tượng với hộp thoại Align 

Hộp thoại Align giúp bạn sắp xếp và canh hàng các đối tượng một cách chính 

xác. 

Align: Cách sử dụng hộp thoại Align để canh hàng các đối tượng theo cạnh trái, 

phải, trên, dưới, hoặc theo trung tâm. 

Distribute: Sử dụng các tùy chọn phân phối để tạo khoảng cách đều giữa các đối 

tượng. 

2.2. Các thao tác lệnh trong Menu Object / Path 

Các lệnh trong menu Object / Path giúp bạn thao tác và hiệu chỉnh các đối tượng 

vector một cách chi tiết. 

2.2.1. Join 

Kết nối hai hoặc nhiều đoạn path lại với nhau. 

Phím tắt: Ctrl + J (Windows) / Command + J (Mac) 

2.2.2. Average 

Làm trung bình các điểm neo để căn chỉnh các đoạn path. 

2.2.3. Outline Stroke 

Biến các đường viền (stroke) thành đối tượng có thể chỉnh sửa được. 
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2.2.4. Offset Path 

Tạo một đường path mới cách đều so với đường path gốc. 

2.2.5. Simplify 

Giảm số lượng điểm neo trên đường path mà vẫn giữ nguyên hình dạng tổng 

thể. 

2.2.6. Add Anchor Points 

Thêm điểm neo vào đường path hiện có. 

2.2.7. Remove Anchor Points 

Xóa các điểm neo khỏi đường path. 

2.2.8. Divide Objects Below 

Chia đối tượng thành các phần khác nhau bằng cách sử dụng một đối tượng 

khác làm mẫu cắt. 

2.2.9. Split Into Grid 

Chia đối tượng thành các ô lưới đều nhau. 

2.2.10. Clean Up 

Xóa các đối tượng không cần thiết hoặc lỗi trong bản vẽ. 

2.3. Các chức năng trong hộp thoại PathFinder 

PathFinder là một công cụ mạnh mẽ giúp bạn tạo ra các hình dạng phức tạp 

bằng cách kết hợp hoặc chia tách các đối tượng. 

2.3.1. Nhóm Shape Modes 

Unite: Kết hợp các đối tượng thành một. 

Minus Front: Trừ đối tượng phía trước khỏi đối tượng phía sau. 

Intersect: Giữ lại phần giao nhau của các đối tượng. 

Exclude: Xóa bỏ phần giao nhau của các đối tượng. 

2.3.2. Nhóm Path Finder 

Divide: Chia các đối tượng thành các phần riêng lẻ dựa trên giao điểm của chúng. 

Trim: Xóa bỏ các phần không giao nhau của các đối tượng. 



TÀI LIỆU THAM KHẢO 

 

 

 

THIẾT KẾ QUẢNG CÁO VỚI ADOBE ILLUSTRATOR 

  43 

 

 

 

Merge: Kết hợp các đối tượng có cùng màu lại với nhau. 

Crop: Cắt các đối tượng theo hình dạng của đối tượng phía trên. 

Outline: Tạo đường viền quanh các đối tượng. 

Minus Back: Trừ đối tượng phía sau khỏi đối tượng phía trước. 

2.4. Công cụ Shape Builder 

Shape Builder Tool cho phép bạn kết hợp, chia tách và tạo các hình dạng phức 

tạp từ các đối tượng khác nhau một cách dễ dàng. 

Phím tắt: Shift + M 

2.5. Giới thiệu về Folder, Packaging (bao bì hộp), túi xách 

2.5.1. FolderBài 4: Màu Sắc và Đường Viền 

Thời gian: 10 giờ 

1. Mục tiêu: 

Tô màu cho đối tượng và đường viền bằng các cách khác nhau: đơn sắc, chuyển 

sắc, lưới. 

Có kiến thức về nhãn đĩa CD. 

Thiết kế được nhãn đĩa CD bằng các công cụ đã học. 

2. Nội dung chương: 

2.1. Khái niệm về màu sắc 

Giới thiệu về màu sắc trong thiết kế. 

2.2. Thao tác với màu sắc 

Tô màu đơn sắc: Sử dụng màu đơn sắc để tô đối tượng. 

Tô màu chuyển sắc: Sử dụng gradient để tạo màu chuyển sắc. 

Tô màu lưới: Sử dụng Mesh Tool để tô màu lưới. 

2.3. Thao tác với đường viền 

Cách thay đổi và hiệu chỉnh đường viền của đối tượng. 

2.4. Giới thiệu về nhãn đĩa CD 
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Các yếu tố cần có trên nhãn đĩa CD. 

2.5. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành thiết kế nhãn đĩa CD. 

2.6. Bài tập 

Yêu cầu sinh viên thực hiện bài tập thiết kế nhãn đĩa CD. 
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Bài 5: Text 
Thời gian: 5 giờ 

1. Mục tiêu: 

Phân biệt được các loại văn bản trong Adobe Illustrator. 

Sử dụng thành thạo các lệnh trong Menu Type và Menu Object. 

Có kiến thức về Brochure. 

Thiết kế được Brochure đơn giản bằng các công cụ đã học. 

2. Nội dung chương: 

2.1. Văn bản trong Adobe Illustrator 

Các loại văn bản: Point Text, Area Text. 

Các phương pháp nhập văn bản: Nhập trực tiếp, nhập qua file. 

Hiệu chỉnh văn bản: Sử dụng hộp thoại Character và Paragraph. 

2.2. Các thao tác lệnh trong Menu Type 

Các lệnh quan trọng trong Menu Type. 

2.3. Các thao tác lệnh trong Menu Object / Text Wrap 

Cách sử dụng Text Wrap để bố trí văn bản quanh đối tượng. 

2.4. Các thao tác lệnh trong Menu Object / Envelope Distort 

Sử dụng Envelope Distort để biến dạng văn bản. 

2.5. Clipping Mask 

Tạo Clipping Mask để hiển thị văn bản trong một hình dạng cụ thể. 

2.6. Giới thiệu về Brochure 

Các yếu tố cần có trong Brochure. 

2.7. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành thiết kế Brochure. 

2.8. Bài tập 
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Yêu cầu sinh viên thực hiện bài tập thiết kế Brochure. 
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Bài 6: Blend, Brush và Symbol 
Thời gian: 11 giờ 

1. Mục tiêu: 

Sử dụng thành thạo các công cụ Blend, Brush, Symbol. 

Có kiến thức về lịch, thiệp, bìa tạp chí, backdrop. 

Thiết kế được lịch, thiệp, bìa tạp chí, backdrop đơn giản bằng các công cụ đã 

học. 

2. Nội dung chương: 

2.1. Blend 

Sử dụng Blend Tool để tạo các hiệu ứng chuyển tiếp mượt mà giữa các đối 

tượng. 

2.2. Brush 

Sử dụng Brush Tool để vẽ và tạo các hiệu ứng đặc biệt. 

2.3. Symbol 

Sử dụng Symbol để quản lý và tái sử dụng các đối tượng đồ họa. 

2.4. Mask 

Sử dụng Mask để ẩn và hiển thị một phần của đối tượng. 

2.5. Giới thiệu về lịch, thiệp, bìa tạp chí, backdrop 

Lịch: Thiết kế lịch theo tháng hoặc năm. 

Thiệp: Thiết kế thiệp chúc mừng. 

Bìa tạp chí: Thiết kế bìa tạp chí chuyên nghiệp. 

Backdrop: Thiết kế backdrop cho sự kiện. 

2.6. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành thiết kế các sản phẩm trên. 

2.7. Bài tập 

Yêu cầu sinh viên thực hiện bài tập thiết kế lịch, thiệp, bìa tạp chí, backdrop. 
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Bài 7: Effect và Filter 
Thời gian: 8 giờ 

1. Mục tiêu: 

Sử dụng thành thạo các hiệu ứng trong Menu Effect và Filter. 

Có kiến thức về bảng hiệu, poster, standee và bộ sản phẩm quà tặng. 

Thiết kế được bảng hiệu, poster, standee đơn giản bằng các công cụ đã được 

học. 

2. Nội dung chương: 

2.1. Hiệu ứng 3D 

Sử dụng các hiệu ứng 3D để tạo các đối tượng ba chiều. 

2.2. Hiệu ứng Distort & Transform 

Sử dụng các hiệu ứng để làm biến dạng và biến đổi đối tượng. 

2.3. Hiệu ứng Stylize 

Sử dụng các hiệu ứng Stylize để tạo các hiệu ứng đặc biệt. 

2.4. Hiệu ứng Warp 

Sử dụng hiệu ứng Warp để biến dạng đối tượng theo hình dạng cụ thể. 

2.5. Filter 

Sử dụng các bộ lọc để tạo các hiệu ứng nghệ thuật. 

2.6. Công cụ Liquify 

Sử dụng Liquify để biến dạng đối tượng bằng cách kéo, đẩy, và vặn. 

2.7. Giới thiệu về bảng hiệu, poster, standee và bộ sản phẩm quà tặng 

Bảng hiệu: Thiết kế bảng hiệu quảng cáo. 

Poster: Thiết kế poster quảng cáo. 

Standee: Thiết kế standee quảng cáo. 

Bộ sản phẩm quà tặng: Thiết kế bộ sản phẩm quà tặng cho doanh nghiệp. 

2.8. [Thực hành] Demo cho SV 
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Hướng dẫn sinh viên thực hành thiết kế các sản phẩm trên. 

2.9. Bài tập 

Yêu cầu sinh viên thực hiện bài tập thiết kế bảng hiệu, poster, standee và bộ sản 

phẩm quà tặng. 

Folder là các bìa cứng hoặc nhựa dùng để chứa tài liệu. 

Đặc điểm: Thiết kế đơn giản, dễ nhận diện, có thể gấp lại. 

2.5.2. Packaging (Bao bì hộp) 

Packaging là các loại bao bì được thiết kế để chứa và bảo vệ sản phẩm. 

Đặc điểm: Thiết kế hấp dẫn, chắc chắn, phù hợp với sản phẩm. 

2.5.3. Túi xách 

Túi xách là các loại túi được sử dụng để mang và chứa các vật dụng. 

Đặc điểm: Thiết kế thời trang, tiện lợi, bền chắc. 

2.6. [Thực hành] Demo cho SV 

Hướng dẫn sinh viên thực hành hiệu chỉnh các đối tượng bằng các công cụ Align, 

PathFinder, và Shape Builder. 

Demo tạo một thiết kế Folder, Packaging, và túi xách đơn giản. 

2.7. Bài tập 

Yêu cầu sinh viên thực hiện các bài tập thực hành sử dụng các công cụ đã học 
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